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1. What’s new for the EPM/FOP role? 
 
 

2. Adding Equipment, Personnel and Supervisors to 
Contractors on a contract 

 Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction>Contract Vendor Assets  

1. In the search box, enter your contract number. 

2. Click on the row action button for the first Contractor and select Open equipment 

 

3. Click on the drop down next to the New button and choose Select Vendor Equipment. 

 

 

4. Enter an Effective Date (usually today’s date) 

5. In the Status box, choose Active. 
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**Entering this information before choosing the equipment will fill in the effective date 
and status for all of the equipment you choose in the next steps – otherwise you must 
choose the date and status for each row 

6. In the search box, hit enter 

7. Choose the equipment that will be used by clicking on the row listing the equipment type  
or for multiples hold down your Control key and click on each type you wish to add .  You 
can also select All (in blue under the search box) to add all generic equipment. 

8. Click on Add to Contract Vendor. 

9. Click on the Personnel tab on the left side. 

10. Click on the drop down next to the New button and choose Select Vendor Personnel. 

11. Enter an Effective Date (usually today’s date). 

12. In the Status box, choose Active. 

13. In the search box, hit enter 

14. Choose the personnel that will be used by clicking on the row listing the personnel type  
or for multiples hold down your Control key and click on each type you wish to add .  You 
can also select All (in blue under the search box) to add all generic personnel. 

15. Click on Add to Contract Vendor. 

** If you would like to add custom Equipment or Personnel, you can do so by clicking 
New on the right side of the tab and filling in the information.  The custom entries will 
only show on your contract forr this contractor. You can also customize the generic 
equipment by typing in an equipment ID (up to 50 characters – like 2011 GMC for 
pickup) 

16. Click on the Supervisors tab on the left side. 

17. Click on the drop down next to the New button and choose Select Vendor Staff. 

18. Enter an Effective Date (usually today’s date). 

19. In the Status box, choose Active. 

20. In the search box, hit enter 

21. Choose the staff by clicking on the row listing the staff and holding down your Control 
key or select All (in blue under the search box). 

22. Click on Add to Contract Vendor. 

23. Click on the Overview quick link near the top of the page. 

24. Click on the row action for the next contractor and add the equipment, personnel and 
staff for each contractor by repeating steps 2-21. 

**The subcontracts must be added in Helena before they will show up in the Contract 
Vendor Asset window 
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3. Run the Contract Material Acceptance Report and save 
the report 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

25. Click on the Global Action button 

26. Select Generate Report 

27. In the Search field enter material 

28. Click on the Contract Material Acceptance (Checklist) row 

29. In the Search field enter 07817X 

30. Click on select all 

31. Click the Execute button 

32. Verify that the report was generated 

33. Select File 

34. Select Save As… 

35. Browse to C:\DGN 

36. In the File name field enter 07817X_SamplingTestingReport.pdf 

37. Click Save  
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4. Add materials to a Project Specific material set 
 

Login 

Username: Uxxxx Password: xxxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > 07817X   

 

1. Click on the Contract Materials and Acceptance Actions quick link 

2. Click on the Materials Tab 

3. In the Search field enter proj 

4. Click on the Row Actions button of the 0010 - MISCELLANEOUS WORK / Project 
Specific Material Set and select Add Material. 

5. In the Material field enter lime 

6. Select 713.02.00.01 Hydrated Lime 

7. In the Conversion Factor field enter 1 

8. Click Save 

9. Verify that the number changes to 1 in the Materials count column 

10. Click on the Acceptance Actions Tab 

11. Locate the 0010 - MISCELLANEOUS WORK item and verify there is a row for 
713.02.00.01 – Hydrated Lime 

12. Expand the row by clicking on the > symbol in the top left corner 

13. Verify that an Acceptance Action for PMS Additive Acceptance was automatically 
added 

14. Click on the PMS Additive Acceptance link 

15. Verify that there are 2 options for acceptance, Hydrated Lime Testing & Cert and QPL 
Verification 

16. Expand the Hydrated Lime Testing & Cert option by clicking on the > symbol in the top 
left corner 

17. Verify that there are 3 acceptance actions for Hydrated Lime Sieve Analysis via a 
Sample Record, Hydrated Lime Chemical Properties via a Sample Record and 
Certification Review via a Daily Work Report 

18. Expand the QPL Verification option by clicking on the > symbol in the top left corner 

19. Verify that there is 1 acceptance action for QPL Verification via a Daily Work Report 
20. Click on the Contract Materials and Acceptance Actions quick link 
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21. Click on the Materials Tab 

22. Click on the Row Actions button of the 0010 - MISCELLANEOUS WORK / Project 
Specific Material Set and select Add Material. 

23. In the Material field enter deck 

24. Select 551.03.02.06 – Concrete-Class Deck 

25. In the Conversion Factor field enter 1 

26. Click Save 

27. Verify that the number changes to 2 in the Materials count column 

28. Click on the Acceptance Actions Tab 

29. Locate the MISCELLANEOUS WORK item and verify there is a row for 551.03.02.06 – 
Class Deck Concrete 

30. Expand the row by clicking on the > symbol in the top left corner 

31. Verify that 4 Acceptance Actions were automatically added for: Concrete Properties, 
Concrete Strength Tests-7, Concrete Strength Tests-28 and Concrete Permeability 

32. Click on the Concrete Properties link 

33. Verify that there is 1 option for acceptance, Concrete Properties  

34. Expand the Concrete Properties option name by clicking on the > symbol in the top left 
corner 

35. Verify that there is 1 acceptance action for Standard Specification 551.03.8  Air Content, 
Slump, and W/CM via a Sample Record with an Action Rate of 1, an Action 
Frequency of 24 and an Frequency Type of Quantity 

36. Click on the Contract Materials and Acceptance Actions quick link 
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5. Create a diary 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817X  

 

1. Click on the Diaries tab 

2. Click Add 

3. Change the Diary Date to 03/12/2018 

4. Verify the Author is your personID 

5. Click Save 

6. In the Weather AM select Cloudy – Cloudy  

7. In the Weather PM select PartlyCloudy – Partly Cloudy  

8. Enter 42 in the Low Temperature 

9. Enter 55 in the High Temperature 

10. Click Save 
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6. Charge a working day on a diary 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Diary from previous exercise  

 

1. Click on the Contract Times tab 

2. Expand the Time ID 00 AT GRADE, GRVL, PMS AND STRUCTURE  

3. In the Original Time Charged field, enter 1   

4. Click Save 

 

7. Review and approve pending DWRs 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Home > Daily Diary > 07817X  

 

1. Click on Diary Date 03/12/2018 

2. Click the DWRs tab 

3. In the search box, click enter 

4. Verify the status on one of the two DWRs is Pending Approval and the other is Draft 

5. For the Pending Approval DWR, click on the row action button and select Approve 

6. Verify the status on the Pending Approval DWR changed to Approved  

 
  



MONTANA DEPARTMENT OF TRANSPORTATION 
AASHTOWare Project Construction and Materials 

 
 

AASHTOWare Help Desk 1-877-406-4338  Page 12 of 65 

 

8. Run the Weekly Report of Time Charges 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

 

1. Click on the Contract Progress quick link 

2. Click on the Weekly Report Of Time Charges tab 

3. Click New 

4. In the Week Ending calendar popup, select 3/10/2018 

5. Click in the Contract Time field and hit enter 

6. Select 00 AT GRADE,GRVL,PMS AND STRUCTURE 

7. Click Save 

8. From the componant action button, select Weekly Report of Time Charges 

9. Enter the Week Ending date of 03/10/2018 

10. Click Execute 

11. Verify there are four Charge days 
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9. Approve the concrete properties test on a deck concrete 
sample 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Materials Worksheets > Review Tests 

1. In the search box, enter 00X (where X is your assigned letter) 

2. Click the box to the left of the Reportable column for the test Concrete Properties (a 

green check mark will appear) 

3. On the very right, click the Row Action button 

4. Click Tasks 

5. Click Mark Test Review By Level 2 

6. Verify the test disappears from the list 

7. Click the Home button 
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10. Authorize a sample record 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Materials Worksheets > Review Samples 

 

1. In the search box, enter 00X (where X is your assigned letter) 

2. On any of the tests, double-click on the Sample Status field 

3. Change the sample status to Complete 

 

Note: It is recommended that the sample record remain in the Complete status until the 

contract is close to Finalization. 

4. Click Save 

5. Verify that all tests changed to sample status Complete 

6. On the very right, on any of the tests, click the Row Action button  

7. Click Tasks 

8. Click Authorize  

9. Verify all tests disappeared 

10. Click the Sample Records Quick Link 

11. In the search box, enter 00X (where X is your assigned letter) 

12. Click on the Sample ID link    

13. Scroll down and verify the Authorized By and Authorized Date fields auto-populated 
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11.   Add a Construction Stockpile 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction>Contract Progress>Contract 07218[x] >Construction Stockpile 

 

1. From the component action menu, select Add. 

2. In the Item field, type plant 

3. Select 0130 401020065 - PLANT MIX SURF GR S-3/8 IN. 

4. Select Save. 

5. Verify that the Description field is auto-populated with the description of the item 

6. In the Comments field enter Material stored at Moon Creek Pit. 

7. In the Invoice Number field enter Letter.  

8. In Invoice Date field enter 05-14-18 

9. In the Invoice Quantity field enter 10000. 

10. In the Invoice Description field enter See letter in share drive requesting payment. 

11. From the drop down list under Project Item Distribution, select 0130 – 
8991039000J01-10-2018 [x] – 0001. 

12. In the Constr Stockpile Amt field enter 10,000. 

13. Select Save. 
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12. Generate a Progress Estimate  
 

Login 

Username: Uxxxx Password: xxxxxxx Role: EPM 

 

Navigation 

Dash Board 

 

The Mob-user DWR needs to be approved before the estimate is run 

 

1. Click on the Contract Progress Component 

2. Select Contract 07817[x] 

3. Click on the Payment Estimates tab.  

4. Click on the Add Payment Estimate button.  

5. Select Period End Date of 01-25-2018 

6. Click the Add Payment Estimate button.  

7. Verify the process started successfully by the message box at top of screen 

8. Click on the Process History Overview quick link at the top of the page. 

9. Look for a process titled AddPaymentEstimate with the current date and time.  

Note: You have to wait until the process is completed. 

10. Verify a Success of Yes. Click on the AddPaymentEstimate.log link. 

Note: When clicking on the AddPaymentEstimate.log a popup will open at the bottom 
of the screen. Click on open to view the log file. 

11. Verify there were no errors in the log file. 

Note: If an error is encountered follow instructions in the .log file. 

12. From the Previous link dropdown, select Contract Progress Summary. 

13. Click on the Payment Estimates tab. 
14. Verify that a Draft Payment Estimate was created (hit enter in the search box). 
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13.   Run Estimate Report 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Dash Board>External Links>Jasper Reports 

 

1. Right click on the Japer Reports link and choose Open in new tab. (This allows you 
to maximize the window) 

2. Enter Windows Login and Password 

3. Click on View > Repository 

4. Under the Folders section on the left side, expand MDT > Protected > 
AASHTOWare  

5. Click on Construction Payment Estimate Report 

6. Select the Contract 07817[X] from the dropdown list 

7. Select Estimate 3 from the dropdown list 

8. Click Apply 

9. Review the report 
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14.   Add a Positive Fuel Price Adjustment 
 

Login 

Username: Uxxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Contract Progress>Contract 07817[x] 

 

1. Go to the Payment Estimates tab 

2. Select Estimate Number 0003. 

3. Select Contract Adjustments Tab 

4. Select New under User Generated Contract Adjustment. 

5. Under Type Select Other Contract Adjustment. 

6. Under Other Contract Adjustment Type Select  Fuel Price – Fuel Price Adjustment.  

7. Enter 540.00 in the Amount Field. 

8. Enter comment of See Fuel Price Adjustment Spreadsheet in Share Drive. 

9. Select Save 
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15.   Override an Estimate Exception 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Dashboard>Contract Progress> Contract 07817[x]>)>Payment Estimates 

 

1. Click on estimate number 0003. 

2. Select Exceptions. 

3. Expand Exception ID 1 

4. From the Status drop down list select Overridden. 

5. Under the Type drop down list EstException – Exception Remark 

6. Under the Remark field enter Change Order in progress. 

7. Select Save. 

8. Run the Jasper report Construction Payment Estimates  

External Links>Jasper 
Reports>View>Repository>MDT>Protected>Construction>Training 

9. Choose your contract 07817(x) and estimate 003.  Apply 

10. On page 10 of the estimate, under Line Item Adjustments This Estimate, Verify the 
Overrun Deduct and Overrun deduct Override balance each other out.  

Materials exceptions and overruns – if you do not override the exception there will be 
a negative dollar amount on the estimate.  All Payroll exceptions must be overridden or 
resolved.  An e-mail goes out to the Labor Compliance Specialist for all payroll exceptions. 
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16.   FOP Approval 
 

Login 
Username: Uxxxx Password: xxxxx Role: FOP 
 
Navigation 
Dash Board>Construction>Payment Estimates> 07817[x] 

 
1. Search on Contract ID or select Show first 10. 
2. Click on Estimate Number 0003 for Contract ID 07817[x]. 
3. From the Component Actions Menu select Submit for Approval. 
4. From the Component Actions Menu select Approve. 
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17.   Create a change order for a non-federal oversight 
(non-PoDI) contract and create a standard explanation. 

 

Login 

Username: Uxxxx Password: xxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07218[x]  

 

1. Click on the Change Orders tab 

2. Click the Add button 

3. Verify that Change Order Date defaults to today’s date 

4. Verify that the Author is your name 

5. In the Description field, enter Additional excavation of soft spots 

6. Under the Approval Rules, select CO – Change Order 

7. Select the Reason EW – Extra Work 

8. Click Save 

9. Verify that the PoDI (FHWA) says No 

10. Verify that the Entered By and Entered Date fields are populated 

11. In the Seq Nbr field under Change Order Explanation, enter 1  

12. In the Standard Explanation Name field, type ex and select Unsuitable Material 

13. Verify that Standard Explanation Description populated with “Remove and dispose of 
unsuitable material…” 

14. Click Save 
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18.  On a non-PoDI contract, add an item increase and 
a new contract item totaling more than $50,000 and 
verify the approval groups. 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Change order from previous test case for 07218[x] “Additional excavation of soft spots“ 

 

1. Click the Increase/Decrease Items tab 

2. Click the Select Items button 

3. In the search field, type dig 

4. Select item 203020278 - EXCAVATION-DIGOUTS 

5. Click Add to Change Order 

6. In the Quantity field, enter 1,022 

7. Click Save 

8. Click the New Items tab 

9. Under the Contract Items section, click the Select Contract Item button 

10. In the Contract Item search field, type dig 

11. Select item 0040 203020278 - EXCAVATION-DIGOUTS 

12. Select project 8902353000[x] SF - 149 ROUNDUP SAFETY IMPRV Category 0001 

13. Click Add to Change Order 

14. In the Project Item Line Number field, change the number to 902010 

15. In the Contract Item Line Number field, change the number to 902010 

16. n the Quantity field, enter 278    

17. Click Save 

18. Verify the change order Amount at the top is $53,300.00 

19. Click on the Review Tracking tab 

20. Click Select Reviewers 

21. Change the custom filter from System Default to 5-Billings CO 

22. Click All 

23. Click Save 

24. Verify that a warning message appears indicating that the New Contract Item has 
modified the Current Quantity 
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25. Close the warning box 

26. Verify the Status changed to Pending Review 

27. Click the Home button 

28. Click the Approval Tracking tab 

29. Click the down arrow and select Assign Default Approval Groups  

30. Verify the following roles are added: 

1 – Contractor, 2 – EPM, 3 – Construction Reviewer, 4 – District Construction 
Engineer, 5 – District Administrator, 6 – Construction Administration Engineer 
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19.   Submit a change order for approval and review the 
change order report. 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Change order from previous test case for 07218[x] “Additional excavation of soft spots“ 

 

1. Under the Component Action button, select Submit for Approval 

2. Verify the warning message “Change Order New Item has modified the Current 
Quantity of Contract Item” appears 

3. Under the Component Action button, select MDTChangeOrderReport 

4. Click Execute 

5. Verify the Net CO Amount is $53,300.00 

6. Verify both bid items are on the report 

7. Close the window 

8. Click the Previous button 
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20. Other Examples of EPM/FOP items 

21.   Add a non-default recurring time to contract. 
Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[x] > Contract Times Tab > 
Recurring 

 

1. Go to the Recurring row (collapse the Informational and Site Times) 

2. Click on the Select RecurringTimes button 

3. In the search box, type Strip 

4. Select the Time ID STRIPEDEADLINE record 

5. Click the Add to Contract Times button 

6. Click Save 

7. Expand the Recurring row 

8. Click on STRIPDEADLINE  

9. In the Effective Date feild, choose today’s date. 

10. In the Status field, choose Active. 

11. Click on the Recurring Time Occurrences tab.   

12. In the Planned Occurrence field, enter a future date 

13. Click Save 
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22. Add material to a material set and additional 
options for material acceptance 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

1. Click on the Materials Tab 

2. In the Search field enter opt 

3. Click on the Row Actions button of the 0570 - Curb and Gutter-Conc 
(609010200)/Class General-Optimized Material Set and select Add Material 

4. In the Material field enter crush 

5. Select 701.02.04.02 Crushed Base Coarse Grade 6A 

6. In the Conversion Factor field enter 1 

7. Click Save 

8. Verify that the number changes to 7 in the Materials count column 

9. Click on the Acceptance Actions Tab 

10. In the Search field enter curb and 

11. Locate the Curb and Gutter- Conc item on Class General-Optimized Material Set and 
verify there is a row for 701.02.04.02 – Crushed Base Coarse Grade 6A 

12. Expand the row by clicking on the > symbol next to the Project number 

13. Verify that 2 Acceptance Actions were automatically added for Compaction Testing 
and Comparison Testing 

14. Click on Compaction Testing 

15. Expand the Compaction Testing Option by clicking on the > symbol next to the Option 
Name 

16. Verify there is a Proctor - MT 210 / MT 230 test via a Sample Record 

17. Click on the Row Action menu on the far right of the Option Description 

18. Click Select Action Relationship 

19. In the Search field enter sieve 

20. Click the MT 202 - Sieve Analysis test and select Add to Option 

21. Click > symbol to expand the Sieve Analysis Option 

22. In the Action Rate field enter 1  

23. In the Frequency Type dropdown list select Contract  
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24. Click Save 

 

 

23. Create a diary adjustment on a working day site 
time 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817X 

 

1. Go to the Weekly Report of Time Charges tab 

2. Click Show first 10 (if not expanded) 

3. From the row action for Week Ending 12/09/2017 for Contract Time 00 AT-GRADE, 
GRVL, PMS AND STRUCTURE, under Reports, select Weekly Report of Time Charges 

4. Click Execute 

5. Verify 12/06/2017 is a Charge day 

6. Close the window 

7. Click the Previous button 

8. Go to the Diary Adjustments tab 

9. Click Select Diary Contract Time Charges 

10. In the search box, enter 12/06/17  

11. Select the Time ID 00 AT 

12. Click Add to Diary Adjustments 

13. Click the > to expand the section 

14. In the Current Time Charge field, enter 0 

15. In the Comments field, enter Winter suspension 

16. Click Save   

17. Go to the Weekly Report of Time Charges tab 

18. From the row action for Week Ending 12/09/2017 for Contract Time 00 AT, under 
Reports, select Weekly Report of Time Charges 

19. Click Execute 

20. Verify under the Diary Adjustments This Week section that 12/06/2017 is a No Charge 
day 

21. Close the window 
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24. Charge a calendar day on a milestone and a no-
charge day on the main site time 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Home > Construction > Contract Progress > Contract 07817X > Diaries tab 

 

1. Click Show first 10 

2. Click the Diary Date 03/09/2018 

3. Click the Contract Times tab 

4. Click on the Milestone - Calendar Day record to expand it 

5. In the Original Time Charged field, enter 1 

6. Click Save 

7. Click on the row for the Time ID 00 ATGRADE, GRVL, PMS AND STRUCTURE to 
expand it 

8. In the Original Time Charged field, enter 0 

9. In the Credit Reason dropdown, select OTHER – Other – See Comments 

10. In the Comments field, enter Too much rain to work 

11. Click Save 
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25. Create a meeting record 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817[x]  

 

1. Click on the Contract Documentation quick link. 

2. Click on the Meetings tab. 

3. Click the Add button 

4. In the Meeting Title enter Pre-Construction Meeting 

5. In the Meeting Type select PRECON-Preconstruction Meeting 

6. In the Meeting Date select 03/02/18 

7. In the Remarks Type select Meeting Remark – Remark for Meeting 

8. In the Remarks field type Railroad has been invited. 

9. Click Save 
 

Modify a Remark 
 

10. In the Remarks Field Change Railroad to BNSF  

11. Click Save 

 

Delete a Remark 
 

12. Click on the Trash Can next to the Remark  

13. Click Save 
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26. Add a Permit to a contract (Permit that MDT sends 
to the permitting agency) 

 

Login 

Username: U Password:  Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[x]>Permits  

 

1. Click on the Permits tab 

2. Click the New button 

3. In the Permit Type select CWA_404/SEC_10-CWA 404/Section 10 Permit (temporary 
facilities) 

4. In the Submit Date select 01/04/18 

5. In the Remarks type received Contractors 404 and sent it into the Army Corp of 
Engineers 

6. Click Save 

7. In the Obtained Date select 02/14/18 

8. In the Permit ID tab type NWO-2018-01900-MTB 

9. Click Save 

 

27.   Create a plan discrepancy specifying a contract 
project. 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817[x] > Contract Documentation > Plan 
Discrepancies Tab 

 

1. Click the Add button 

2. In the Contract Project ID field hit Enter and select Contract Project ID 5157010000[x] 

3. In the Description field enter Overran special borrow 

4. In the Type dropdown select Field Conditions 

5. In the Remark field enter Pavement blew out at Station 52+25 

6. Click Save 
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28. Create a DWR for Steel Certification Acceptance 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Daily Work Reports 

 

1. Click the Component Action button and Select Contract to Add DWR. 

2. Check the Contract ID 07817[X] Milk River - North row. 

3. Click on the Create DWR on Contract button. 

4. Verify that the DWR Date and Inspector fields are auto-populated with the current date 
and user. 

5. Click Save. 

6. Select Contractors Tab 

7. Click Select Contractors button 

8. Click on Vendor ID 7122 REEVERTS FENCING LLC 

9. Click on Add to DWR Contractors button 

10. Click Save 

11. Click on Work Items Tab 

12. Click Select Items button 

13. Type single in the Search field 

14. Select Project Line Item 0490 – 607100362-FARM FENCE-PANEL/SINGLE FM from the 
list 

15. Click the Save button 

16. Click on the Item Row Action button and select New Posting 

17. Select 7122 REEVERTS FENCING LLC (Sub) in the Contractor field 

18. In the Station From field type 25+00  

19. In the Station To field type 40+00  

20. In the Location/Description field type Steel certification review.  

21. In the Material Set field, verify that Farm Fence Panel – Single FM is auto-populated 

22. Click Save. 

23. Click on the Acceptance Records Tab 

24. Expand the Farm Fence – Panel/Single FM by clicking on the > arrow 

25.  Expand the 712.02.00.01 - Fence Wire section by clicking on the > arrow. 

26. In the Source ID field hit enter and select Oklahoma Steel & Wire from the list 

27. From Field Inspection Value dropdown list select STL – Steel Cert Reviewed 

28. From the Certification comparison to MDT Specs dropdown list select Meets Specs 

29. From the Form 406 dropdown list select Meets Specs 
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30. Click Save 

31. Click on the > arrow to Expand the section 

32. Click on the Material Row Action button and select Attachments 

33. Click the Select File button 

34. Browse to folder and select Fence_Wire_406Certs.pdf 

35. Click Open 

36. Enter Form 406 in the Description field 

37. Click Save 

 

29. Acknowledge an Estimate Exception 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Payment Estimates>Contract 07817[x] 

 

1. Click on Estimate number 0003 link 

2. Click on the Exceptions tab 

3. Expand Exception number 1 for Insufficient Materials. 
4. In the Status field, select Acknowleged. 
5. In the Type dropdown field select Exception Remark  
6. In the Remark field enter Sample taken, waiting for test results. 
7. Expand Exception number 2 for Item Overrun. 
8. In the Status field, select Acknowleged. 
9. In the Type dropdown field select Exception Remark  
10. In the Remark field enter Change Order in progress 
11. Expand Exception number 3 for Item Overrun. 
12. In the Status field, select Acknowleged. 
13. In the Type dropdown field select Exception Remark  
14. In the Remark field enter Change Order in progress 
15. Expand Exception number 4 for Item Overrun. 
16. In the Status field, select Acknowleged. 
17. In the Type dropdown field select Exception Remark  
18. In the Remark field enter Change Order in progress 
19. Click Save 
20. From the Component Action Item menu select Payment Estimate For Contractor 

21. Select Execute 

22. Verify the Contract Itm Line Num 0130 and 0140 on the Adjustment Type: Overrun 
line has a negative amount in the Pay AMT This Pay Estimate column. 
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30. Document Submission for PCC Mix Design 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress 

1. In the Search Box, enter 07817[X]  . 

2. In the Contract Column ID select 07817[X] link. 

3. At the top of the page, click the Contract Documentation link. 

4. Click the Document Submission tab. 

5. Click New. 

6. In the Description Field, enter Class General Mix Design Submittal. 

7. In the Submitted Date field, enter 02/15/2018. 

8. In the Submitter field, verify your name auto-populated. 

9. From the Type drop-down, Select MIXDESIGN – Mix Design Submittal. 

10. Click Save. 
 

31. Verify Work Begin date populated by trigger. 
Login 

Username: U Password:  Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[x] > Contract Times tab > 
Informational 
 

1. In the search box, enter beg 

2. Verify the WKBGN-DT field automatically populated to 10/25/2017 

3. Click on the Home button 

 

 

32.   Populate multiple Bridge Opening dates. 
Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 
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Construction > Contract Administration > Contract 07817[x] > Contract Times tab > 
Informational 
 

1. In the search box, enter brid 

2. In the Actl Compl field for BRIDGEOPEN, select 10/02/2017 from the date picker 

3. In the Comments field, type ABC Bridge opened to traffic 

4. Click Save 

5. Click on Select Informational Times  

6. In the search box, type Bridge  

7. Select BRIDGEOPEN 

8. Click Add to Contract Times 

9. In the Actl Compl field for BRIDGEOPEN (no data), select 02/05/2018 from the date 
picker 

10. Change the Time Descr field to Bridge opening 2 – EPM 

11. In the Comments field, type DEF Bridge open to traffic  

12. Click Save 
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33. Change Sample Rate and Frequency for acceptance 
on small quantity 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[x] > Contract Materials & 
Acceptance Actions 
1. Click on the Acceptance Actions tab 

2. In the Search field enter 701.01.03.01 

3. Click > symbol to expand Curb 4 IN - Concrete (609010112) - 701.01.03.01 - 
Combined Concrete Aggregate on Class General-Optimized Material Set 

4. Click on Gradation Testing Acceptance Action 
5. Click > symbol to expand Gradation Testing option 

6. On the MT 202 – Sieve Analysis test, change the Action Rate to 0 

7. In the Comments field enter UXXXX Accepted based on small quantities 

8. Click Save.  

9. Click the Contract Materials and Acceptance Actions link at the top of the page. 

10. Click > symbol to expand Curb 4 IN - Concrete (609010112) - 701.01.03.01 - 
Combined Concrete Aggregate 

11. Click on Comparison Testing Acceptance Action 
12. Click > symbol to expand Gradation Testing option 

13. Click > symbol to expand MT 202 Field – Sieve Analysis (IA Comparison) test  

14. Change the Action Rate to 0 

15. In the Comments field enter UXXXX Accepted based on small quantities 

16. Click on the Contract Materials and Acceptance Actions Summary quick link 

17. Click on the Comparison Testing link. 

18. Expand the Gradation Testing Option  

19. Click > symbol to expand MT 202 District/Area – Sieve Analysis (IA Comparison) test  

20. Change the Action Rate to 0 

21. In the Comments field enter UXXXX Accepted based on small quantities 

22. Click > symbol to expand MT 202 HQ Materials– Sieve Analysis (IA Comparison) test  

23. Change the Action Rate to 0 

24. In the Comments field enter UXXXX Accepted based on small quantities 

25. Click > symbol to expand IA Grading Comparison test  

26. Change the Action Rate to 0 



MONTANA DEPARTMENT OF TRANSPORTATION 
AASHTOWare Project Construction and Materials 

 
 

AASHTOWare Help Desk 1-877-406-4338  Page 36 of 65 

27. In the Comments field enter UXXXX Accepted based on small quantities 

28. Click Save 

29. Click on the Contract Materials and Acceptance Actions quick link 
 
 

34.   Change Sample Rate for an emulsion material 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

 

1. Click on the Acceptance Actions tab. 

2. In the Search field enter emul 

3. Click > symbol to expand Emulsified Asphalt CRS-2P (402020368) – 702.01.06.02 on 
Project 5157010000[x] 

4. Click on the Emulsion Acceptance Action 

5. Click > symbol to expand Emulsion Test – Sample & Cert option. 

6. Click > symbol to expand Sample Record/Emulsified Asphalt Testing option. 

7. Change the Action Rate to 3. 

8. Change the Frequency Type to Contract. 

9. Blank out the Action Frequency. 

10. In the Comments field enter UXXXX -There were only 3 tankers. Therefore only 3 
samples taken 

11. Click Save.  

12. Click the Contract Materials and Acceptance Actions link at the top of the page. 
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35.   Add additional options for material acceptance 
 

Login 

Username: Uxxxx Password: xxxxxxx Role: EPM 

 

Navigation 

 

1. Click on the Materials Tab 

2. In the Search field enter general 

3. Click on the Row Actions button of the 0300 - Concrete – Class General (551020030)/ 
Class General-Optimized Material Set and select Add Material. 

4. In the Material field enter crush 

5. Select 701.02.04.02 Crushed Base Coarse Grade 6A 

6. In the Conversion Factor field enter 1 

7. Click Save 

8. Verify that the number changes to 6 in the Materials count column 

9. Click on the Acceptance Actions Tab 

10. In the Search field enter 551020030 

11. Locate the Concrete – Class General item and verify there is a row for 701.02.04.02 – 
Crushed Base Coarse Grade 6A 

12. Expand the row by clicking on the > symbol next to the Project number. 

13. Verify that there are 2 Tests for acceptance, Compaction Testing and Comparison 
Testing 
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36.   Adding a remark for explanation of required 
number of binder samples not taken 

Login 

Username: Uxxxx Password: xxxxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > 07817[x] > Contract Materials and Acceptance Actions 

 

1. Click on the Acceptance Actions tab. 

2. In the Search field enter 64-28 

3. Click > symbol to expand ASPHALT CEMENT PG 64-28 (402020092) – 702.02.09.10 
(Performance Graded Asphalt Binder)  

4. Click on the PGAB Acceptance Acceptance Action 

5. Click > symbol to expand Daily Work Report\Sample Witness. 

6. Change the Action Rate to 9 

7. Change the Frequency Type to Contract 

8. Blank out the Action Frequency 

9. In the Comments field enter UXXXX - The required frequency calculates to 9.08. 9 
samples were witnessed.  A 10th sample was not taken due to the small quantity 
difference at the end of the work. 

10. Click Save. 

11. Click the Contract Materials and Acceptance Actions link at the top of the page. 

12. Click on the Global Actions button 

13. Select Generate Report 

14. In the Search field enter Samp 

15. Click on Sampling and Testing Status Report 

16. In the Search field enter 07817[x] 

17. Scroll down and check the ASPHALT CEMENT PG 64-28 row 

18. Click the Execute button 

19. On page 1 of the report, verify that the Comment added in step 14 displays under the 
Certification – DWR option. 
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37. Create a DWR for QPL acceptance 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation of previous use case 

 

1. Click the Previous button 

2. Click on Work Items button 

3. Click Select Items button 

4. Type det in the Search field 

5. Select Project Line Item 0550 608010125-DETEC WARNING DEVICES-TYPE 1 

6. Click the Save button 

7. Click on the Item Row Action button and select New Posting  

8. Verify that SK CONSTRUCTION, INC. (Prime) is auto-populated in the Contractor field 

9. In the Location/Description Field, type QPL Verification. 

10. In the Material Set field, Verify that DWD Type 1 is auto-populated 

11. Click Save. 

12. Click on the Acceptance Records Tab 

13. Click on the > arrow to Expand the section 

14. Hit enter in the Source ID field and select EJ (East Jordan Iron Works Inc) from the list 

15. Hit enter in the Product Name/Seal#/Batch/Lot field and select Duralast from the list 

16. Select QPLSTL – QPL Verified/Steel Cert Reviewed from Field Inspection Value 
dropdown list 

17. Select Meets Specs from the Certification comparison to MDT Specs dropdown list 

18. Select Meets Specs from the Form 406 dropdown list 

19. Click Save 

20. Click on the > arrow to Expand the section 

21. Click on the Material Row Action button and select Attachments 

22. Click the Select File button 

23. Browse to folder and select DETECTABLE_WARNING_DEVICES.pdf 

24. Click Open 

25. Enter Form 406 and Certifications in the Description field 

26. Click Save 

  



MONTANA DEPARTMENT OF TRANSPORTATION 
AASHTOWare Project Construction and Materials 

 
 

AASHTOWare Help Desk 1-877-406-4338  Page 40 of 65 

38. Create a diary adjustment to a previous diary      
adjustment 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817X 

 

1. Go to the Weekly Report of Time Charges tab 

2. Click Show first 10 (if not already expanded) 

3. From the row action for Week Ending 11/25/2017 for Contract Time 00 AT-GRADE, 
GRVL, PMS AND STRUCTURE, under Reports, select Weekly Report of Time Charges 

4. Click Execute 

5. Verify 11/24/2017 is a Charge day and under the Diary Adjustments This Week section 
that 11/24/2017 is a No Charge day 

6. Close the window 

7. Click the Previous button 

8. Go to the Diary Adjustments tab 

9. Click Select Diary Contract Time Charges 

10. In the search box, enter 11/24/17 

11. Select the Time ID 00 AT 

12. Click Add to Diary Adjustments 

13. Click the row to expand it 

14. In the Current Time Charge field, enter 1 

15. In the Comments field, enter Impacted traffic 

16. Click Save 

17. Go to the Weekly Report of Time Charges tab 

18. From the row action for Week Ending 11/25/2017 for Contract Time 00-GRADE, 
GRVL, PMS AND STRUCTURE, under Reports, select Weekly Report of Time Charges 

19. Click Execute 

20. Verify under the Diary Adjustments This Week section that 11/24/2017 has a No Charge 
day and a Charge day 

21. Close the window 
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39. Create a diary adjustment on a calendar day 
milestone that was not originally charged, and the diary 
is locked 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817X 

 

1. Go to the Weekly Report of Time Charges tab 

2. Click New 

3. In the Week Ending calendar popup, select 11/25/2017 

4. Click in the Contract Time field and hit enter 

5. Select MLSTNCD 

6. Click Save 

7. From the row action button, under Reports, select Weekly Report of Time Charges 

8. Click Execute 

9. Verify the Time Charged column is blank on 11/23/2017 

10. Close the window 

11. Click the Previous button 

12. Go to the Diary Adjustments tab 

13. Click Select Diary Contract Time Charges 

14. In the search box, enter 11/23/17 

15. Select the Time ID MLSTNCD 

16. Click Add to Diary Adjustments 

17. Click the row to expand it 

18. In the Current Time Charge field, enter 1 

19. Click Save 

20. Go to the Weekly Report of Time Charges tab 

21. From the row action for Week Ending 11/25/2017 for Contract Time MLSTNCD, under 
Reports, select Weekly Report of Time Charges 

22. Click Execute 

23. Verify under the Diary Adjustments This Week section that 11/23/2017 has a Charge 
day 

24. Close the window 
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40. Add Attendees Manually 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

Attendees 

 

1. Click the New button 

2. In the Title type District Construction Engineer 

3. In the First Name type Mike  

4. In the Last Name type Taylor 

5. In the Organization type MDT 

6. In the Email Address type mctaylor@mt.gov 

7. In the Phone Number type 406-657-0233 

8. Click Save 

 

41. Add Attendees from Persons 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

Attendees 

 

 

1. Click the Down Arrow next to the New button 

2. Click Select Attendees under Actions 

3. In the Search Box type Durbin 

4. Select Lisa Durbin 

5. Click Add to Attendees 

6. Click Save 
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42. Delete an Attendee 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

Attendees 

1.  

2. Click the Row Action Button next to Lisa Durbin 

3. Click Delete under Actions 

4. Click Save 

 

 

 

43. Add an Attachment to a Meeting – Attendance  
Roster 

 
Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

 

 

1. Open Component Actions Menu 

2. Select Attachments 

3. Click Select File 

4. In the share drive folder select Precon_Sign In Sheet 

5. Click Open 

6. In Description Filed type Attendance Roster for Milk River – North - Pre-Construction 
Conference 

7. Click Save 
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44. Add a Contractor obtained Permit to a contract  
 

Login 

Username: U Password:  Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[x] >Permits  

 

1. Click the New button 

2. In the Permit Type select 318_AUTH-318 Authorization 

3. In the Obtained Date select 03/01/18 

4. In the Remarks type received Contractors 318 Authorization – see attachment  

5. In the Permit ID tab type MTB001234 

6. Click Save 

45.   Attach a permit to a Contract 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

 

1. Click the Down Arrow next to the Save button 

2. Click Attachments under Views 

3. Click Select File 

4. Navigate to your team folder and select 318_Authorization.pdf 

5. Click Open 

6. Click Save 
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46.   Add an item to a plan discrepancy associated with 
a contract project. 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation of previous test case 

 

1. Click on the Contract Project Items tab 

2. Click the Select Contract Project Items button 

3. In the Search field hit Enter 

4. Verify that only items from Contract Project ID 5157010000[x] are listed 

5. In the Search field type crush 

6. Check the CRUSHED AGGREGATE COURSE item 

7. Click the Select Contract Project Items button 

8. Verify the record was saved by clicking Show first 10 

 

47.   Add Error & Omissions remark to an existing plan  
discrepancy 

  

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817[x] > Contract Documentation  

  

 

1. Click on the Plan Discrepancies Tab  

2. Click on the Overran Special Borrow discrepancies link that was created in the 
previous steps 

3. In the Type dropdown select Errors & Omissions 

4. In the Remark field enter Determined that errors & omissions will not be assessed 

5. Click Save 
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48. Start a milestone 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07218[x] > Contract Times tab 

 

1. Under the Site section, click the Time ID 01 link. 

2. Click on the Units and Dates tab. 

3. On the Notice to Proceed / Milestone Start, select 03/08/2018 from the date picker 

4. Click Save. 

5. Click on the General tab. 

6. Enter an Effective Date. 

7. On the Status dropdown list, verify it is Active. 

8. Click Save. 

49. Complete a milestone 
 

Login 

Username: Uxxxx Password: xxxxx  Role: EPM 

 

Navigation 

Construction > Contract Administration > contract 07817[x] > Contract Times tab > Site Time 
component 

 

1. Click on the Time ID MLSTNCD link 

2. Click on the Units and Dates tab 

3. On the Stop Time, select 03/10/2018 from the date picker 

4. Click Save 
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50. Adding quantities to an existing stockpile 
 

Login 

Username: Uxxxx Password: xxxxxxx Role: EPM 

 

Navigation 

Dashboard>Contract Progress>Contract 07817[x] >Construction Stockpile 

 

1. Click on stockpile 0001. 

2. Click on the New button. 

3. Enter Adding additional quantities to existing stockpile. 

4. Enter Letter in the Invoice Number field. 

5. Enter 1-12-2018 in the Invoice Date  

6. Enter 1000 in the Invoice Quantity field. 

7. Enter See letter in share drive requesting payment in the Invoice Description field. 

8. Select 0040 – 9028052000[x] – 0001 from the drop down list under Project Item 
Distribution. 

9. Enter 1000 in the Constr Stockpile Amt field. 

10. Select Save. 

11. Verify that the additional $1,000.00 stockpile payment is included on the estimate. 

12. Verify that an amount is subtracted off the stockpile for the DWR payment. 
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51. Manual Entry of a Positive Milestone Adjustments 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Contract Progress>Contract 07817[x] >Payment Estimates 

 

1. Select Estimate Number 0003. 

2. Select Contract Adjustments. 

3. Select New Under User Generated Contract Adjustment. 

4. From the Type Field select Incentive. 

5. In the Days Field enter 2. 

6. In the Amount field enter 7000 

7. From the Time ID/Description Field select MLSTNCD -Calendar Day (need to click in 
field and enter a return to see descriptions) 

8. Select Save 

9. Verify that the Time Units calculate as 2.  
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52.   Add a Negative Fuel Price Adjustment and 
Distribute to Multiple Projects 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Contract Progress > Contract 07218[x] > Payment Estimates 

 

1. Select Estimate Number 0001. 

2. Select Contract Adjustments Tab. 

3. Select New under User Generated Contract Adjustment. 

4. Under Type Select Other Contract Adjustment. 

5. Under Other Contract Adjustment Type Select  Fuel Price – Fuel Price Adjustment.  

6. Enter -540.00 in the Amount Field. 

7. Enter See Fuel Price Adjustment Spreadsheet in Share Drive. 

8. Select Save 

9. Click on Percentage Under Distributed By 

10. Select Amount Under the Distributed By Field 

11. Click on Save 

12. Under Projects for project 8991039000J - WEST OF ROUNDUP – WEST enter -200.00  

Note: Ignore the prepopulated percentage. 

13. Under Projects for project 8902353000J - SF - 149 ROUNDUP SAFETY IMPRV enter   
-340.00 

Note: Ignore the prepopulated percentage. 

14. Click on Save 
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53.   Positive QA Adjustment 
Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Dash Board 

1. From the dashboard select the Contract Progress Component. 

2. Select contract 07218[x]. 

3. Select Payment Estimates tab 

Note: may need to select show first 10 to display estimates. 

4. Click on Estimate Number 0001. 

5. Select Item Adjustments tab. 

6. Under User Generated Dollar-Based Item Adjustments click on Select Project Items. 

7. Select Line item number 0130 (401020065, PLANT MIX SURF GR S-3/8 IN) 

8. Select Add to Item Adjustments button at bottom of screen. 

9. Under Other Item Adjustment Type Select QA Density – QA Density.  

10. Enter 4,000.00 in the amount field. 
11. Enter For first lift of plant mix in comments field. 
12. Select Save. 

54.   Negative Non-QA Adjustment 
Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Continuation from previous 

1. Select Item Adjustments Quick Link. 

2. Under User Generated Dollar-Based Item Adjustments click on Select Project Items. 

3. Select Line item number 0140 (401020300 - HYDRATED LIME) 

4. Select Add to Item Adjustments button at bottom of screen. 

5. Select Type of Other Item Adjustment. 

6. Under Other Item Adjustment Type Select Non QA Adjustments – Non QA Adjustments.  

7. Enter -1000.00 in the amount field. 
8. Enter comment of See X:\Const\SiteManager_Contracts\CREW_4181\JCT_MT_7-

EAST_18915_4881003\07_MATERIALS\NON-QA\HydratedLime_Deduct.pdf 
9. Select Save. 
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55.  Manual Entry of a Negative Milestone Adjustments 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Contract Progress>Contract 07218[x] > Payment Estimates 

 

1. Select Estimate Number 0001. 

2. Select Contract Adjustments. 

3. Select New Under User Generated Contract Adjustment. 

4. From the Type Field select Disincentive. 

5. In the Days Field enter -2 

6. In the Amount field enter -8000 

7. From the Time ID/Description Field select 01- CURRANT CREEK BRIDGE DIGOUT 
INCENTIVE/DISCINTIVE (need to click in field and enter a return to see descriptions) 

8. Select Save 

9. Verify that the Time Units calculate as -2.00 
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56.   Test that estimate exception is created with an 
item that has not been funded 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Dash Board 

 

1. Click on the Contract Progress Component 

2. Select Contract 16116[x] 

3. Click on the Payment Estimates link.  

4. Click on the Add Payment Estimate button.  

5. Select Period End Date of 01-25-2018 

6. Click the Add Payment Estimate button.  

7. Verify the process started successfully by the message box at top of screen 

8. Click on the Process History Overview quick link at the top of the page. 

9. Look for a process titled AddPaymentEstimate with the current date and time.  

Note: You may have to hit F5 to refresh the page until the process has completed. 

10. Verify a Success of Yes. Click on the AddPaymentEstimate.log link. 

Note: When clicking on the AddPaymentEstimate.log a popup will open at the bottom of 
the screen.  Click on open to view the log file. 

11. Verify there were no errors in the log file. 

Note: If an error is encountered follow instructions in the .log file. 

12. From the Previous link dropdown, select Contract Progress Summary. 

13. Click on the Payment Estimates link. 

14. Search on contract ID or select show first 10. 

15.  Select Contract 16116[x] 
16. Verify that a Draft Payment Estimate was created. 

17. Click on Estimate Number 0001 

18. Click on the Exceptions tab 

19. Verify a Funding Check exception is created   
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57.  Manual Entry of Liquidated Damages 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Contract Progress>Contract 16116[x] > Payment Estimates 

 

1. Select Estimate Number 0001. 

2. Select Contract Adjustments. 

3. Select New Under User Generated Contract Adjustment. 

4. From the Type field select Liquidated Damage. 

Note: The Time ID/Description field will automatically populate. 

5. In the Days Field enter -2  

6. In the Amount field enter -2792  

7. Select Save 

8. Verify that the Time Units calculate correctly as -2. 

 

58.   Delete a Progress Estimate 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Dash Board 

 

1. Click on Payment Estimates Link 

2. In the Search field enter 07218[x] 

3. In the row action items for Contract 07218[x]; Estimate number 0001 select Delete.   

4. Select Save. 

5. Verify estimate was deleted. 
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59. Create a change order for a federal oversight (PoDI) 
contract and create a custom explanation. 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817[x] > Change Order tab 

 

1. Click Add 

2. Verify that Change Order Date defaults to today’s date 

3. Verify that the Author is your name 

4. In the Description field, enter Time extension due to award delay  

5. Under the Approval Rules, select CO-P – Change Order - PoDI 

6. Select the Reason TA – Time Adjustment 

7. Click Save 

8. Verify that the PoDI (FHWA) says Yes 

9. Verify that the Entered By and Entered Date fields are populated 

10. In the Seq Nbr field, enter 1 

11. In the Gen/Supp Explanation field, type Contract time is extended for delays in the 
award of the contract. The delays were beyond the control of the contractor. 

12. Click Save  
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60.   On a PoDI contract, add contract time and verify 
the approval groups. 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Change order from previous test case for 07817[x] “Time extension due to award delay” 

 

1. Click the Time Adjustments tab 

2. Click the Select Contract Time button 

3. Click in the search field and hit enter 

4. Select 00AT GRADE, GRVL, PMS AND STRUCTURE  

5. Click Add Time Adjustments to Change Order 

6. In the Adjustment Time Units field, enter 5  

7. Click Save 

8. Click the Approval Tracking tab 

9. Click the down arrow and select Assign Default Approval Groups  

10. Verify the following roles are added: 

1 – Contractor, 2 – EPM, 3 – Construction Reviewer, 4 – District Construction 
Engineer, 7 – FHWA 
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61. On a non-PoDI contract, add a new contract item 
less than $50,000 to a new category. Extend calendar 
days more than 6 days. Verify the approval groups go 
through CASE. 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM  

 

Navigation 

Construction > Contract Progress > Contract 07218[X] > Change Order tab 

 

1. Click on CO Num 0001 

2. Click the New Items tab 

3. Under the Contract Items section, click the Select Contract Item button 

4. In the Contract Item field, type guard 

5. Choose item 0220 606010040 GUARDRAIL-STEEL BOX BEAM 

6. Select WEST OF ROUNDUP – WEST category 0003 AR 13615 

7. Click Add to Change Order 

8. In the Project Item Line Number field, change it to 901010 

9. In the Quantity field, enter 155 

10. On the Funding dropdown, select AR-O – AR 13615 

11. Click Save 

12. Click the Time Adjustments tab 

13. Click the Select Contract Time button 

14. Click in the search box and hit enter  

15. Select the Time ID 00 AT 

16. Click Add Time Adjustments to Change Order 

17. In the Adjustment Time Units field, enter 10  

18. Click Save 

19. Click the Approval Tracking tab 

20. Click the down arrow and select Assign Default Approval Groups  

21. Verify the following roles are added: 

1 – Contractor, 2 – EPM, 3 – Construction Reviewer, 4 – District Construction 
Engineer, 5 – District Administrator, 6 – Construction Administration Engineer 
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62.   Change a change order that has a rejection back 
to draft, modify the change order and resend it for 
comment. Run the change order report 

 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract JC218[x] > Change Orders tab 

 

1. Click on CO Num 0001 

2. Note the Status at the top is Rejected 

3. Click on the Review Tracking tab 

4. Review the Decision Comments 

5. Click on the Increase/Decrease Items tab 

6. Note the large quantity, the reason for the comment 

7. Under the Component Action button, select Change to Draft 

8. In the Quantity field, change it to 12,050 

9. Click Save 

10. Under the Component Action button, select MDTChangeOrderReport 

11. Click Execute 

12. Verify the Net CO Amount is $12,050 

13. Verify there is not a signature line 

14. Close the window 

15. Click the Previous button 

16. Click on the Review Tracking tab 

17. Click Select Reviewers 

18. Change the custom filter from System Default to 2-Butte CO 

19. Click All 

20. Click Save 

21. Verify the Status changed to Pending Review 

22. Click the Home button 
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63. Submit a change order for review  
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM  

 

Navigation 

Change order from previous test case for 07218[X] “AR 13615, Guardrail Repair”  

 

1. Click on the Review Tracking tab 

2. Click Select Reviewers 

3. Change the custom filter from System Default to 5-Billings CO 

4. Click All 

5. Click Save 

6. Verify that a warning message appears indicating that the New Contract Item has 
modified the Current Quantity 

7. Close the warning box 

8. Verify the Status changed to Pending Review 

9. Click the Home button 

 

 

64.   Test the change order approval process  
 

Login 

Username: Uxxxx Password: xxxxx Role: MDTContractor 

 

Navigation 

Construction > Change Order > Contract 16116[x] > Change Orders tab 

 

1. Click on CO Num 0002 

2. Note the Status at the top is Pending Approval 

3. Click on the Approval Tracking tab 

4. Note the only approval level that has a Decision Requested date is the Contractor 

5. Under the Component Action button, click Approve 

6. In the Approval Decision Comments box, enter Contractor signed change order on 
8/19/18 
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7. Click Save 

8. Change the role to EPM 

9. Under the Component Action button, click Attachments 

10. Click Select File 

11. Navigate to the folder XX 

12. Select file 16116_CO-0002_Signature.pdf 

13. Click Open 

14. In the Description field, enter Contractor ink signature 

15. Click Save 

16. Click the Previous button 

17. Click on the Approval Tracking tab 

18. Note the next level that has a Decision Requested date is the EPM 

19. Under the Component Action button, click Approve 

20. In the Approval Decision Comments box, enter Approved on 8-20-18 

21. Click Save 

 

 

 

 

65.   Review an approved change order  
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Continue from previous test case 

 

1. Click the Contract Progress Quick Link 

2. Click on CO Num 0003 

3. Note the Status at the top is Approved 

4. Under the Component Action button, under Historical Reports, select MDT Change 
Order Report 

5. Click Open to the prompt “Do you want to open or save…” 

6. Verify the Net CO Amount is $8,613.00 

7. Verify it says “Ink Signature on File” under the contractor name 
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8. Verify all of the approval groups and the approval dates are displayed 

9. Close the file 

10. Click the Contract Progress Quick Link 

11. Click the Contract Materials and Acceptance Actions Quick Link 

12. At the bottom of the item list, verify that Item 603012660 Description RCP 36 IN 
CLASS 4 Proj Item 903010 is in the list 

13. Verify the Material Set is RCP 

14. Click the > arrow to expand the row 

15. Verify Material 708.01.01.01 – Reinforced Concrete Pipe and Material 701.04.01.01 
Bedding Material are listed 

16. Click the Home button 
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66.   Use the balance item function. 
 

Login 

Username: Uxxxx Password: xxxxx Role: EPM 

 

Navigation 

Construction > Contract Progress > Contract 07817[x] > Change Order tab 

 

1. Click Add 

2. Verify that Change Order Date defaults to today’s date 

3. Verify that the Author is your u-number 

4. In the Description field, enter Increase Unclassified Borrow to the final quantities  

5. Under the Approval Rules, select CO-P – Change Order - PoDI 

6. Select the Reason QTY – Quantity 

7. Click Save 

8. Verify that the PoDI (FHWA) says Yes 

9. In the Seq Nbr field, enter 1 

10. In the Standard Explanation Name field, type final and select Final Quantity 

11. Click Save 

12. Click on the Items Quick Link 

13. In the search field, enter 203020200 

14. Under the Row Action button, click Mark Item Complete 

15. Verify a warning message displays indicating there are DWR Item Postings not 
associated to a Payment Estimate and that the Quantity Posted exceeds the Current 
quantity 

16. Click the Previous button 

17. Click on the Increase/Decrease Items tab 

18. Click the Balance Completed Items button 

19. In the search box, hit enter 

20. Select Item – Description 203020200 EXCAVATION-UNCLASS BORROW 

21. Click Balance Completed Items 

22. Click the Home button 
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67. Manually Close Out Stockpile 
 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Contract Progress>Contract 07817[x]  

 

1. Click on stockpile 0001. 

2. Click on the New button. 

3. Enter Close Out Stockpile in the Comment field. 

4. Select 0220 – 5157010000[x] – 0001  from the drop down list under Project Item 
Distribution. 

5. Enter – 6737.20 in the Constr Stockpile Amt field. 

6. Select 0410 – 90208052000[x] – 0003  from the drop down list under Project Item 
distribution. 

7. Enter – 1000.00 in the Constr Stockpile Amt field. 

8. Select Save. 

9. From the action menu select Close Stockpile. 

10. Verify the Status has changed to Closed. 
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68.  Populate Final Walk-through time records. 
 

Login 

Username: UXXXX Password:xxxx Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[X] > Contract Times tab 

 

1. On the FINALWALKTHRU, enter 01/01/2018 in the Actl Compl date. 

2. Click Save. 

3. Under Recurring Times, on Punch List Time, click the Expand/Collapse Arrow next to 
ID. 

4. Verify the Planned Occurrence date is 01/31/2018. 

5. On Actual Occurrence date, enter 01/15/2018. 

6. Click Save. 

7. Under Informational Times, on the FINALVER, in Actl Compl date, enter 01/16/2018. 

8. Click Save. 

9. Under Recurring Times, on CONDFINALACCPT, click the Expand/Collapse Arrow 
next to the time ID. 

10. Verify the Planned Occurrence date is 02/15/2018. 

11. On the CONDFINALACCPT recurring time, in the Actual Occurrence date, enter 
02/01/2018. 

12. Click Save. 

13. Next to Recurring Time ID FNLDUEDIST, click the Expand/Collapse Arrow. 

14. Verify the Planned Occurrence date is 03/03/2018. 

15. In the Actual Occurrence date, enter 03/05/2018. 

16. Click Save. 

17. Next to FNLDUEHELENA Time ID, click the Expand/Collapse Arrow. 

18. Verify the Planned Occurrence date is 04/04/2018. 

19. Next to MPDES/NPDES Time ID, click the Expand/Collapse Arrow. 

20. Verify the Planned Occurrence date is 04/07/2018. 

21. Next to FNLMCERT-MICO Time ID, click the Expand/Collapse Arrow. 

22. Verify the Planned Occurrence date is 04/02/2018. 
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69.   Populate actual dates for Seal Coat Inspection and 
Final Acceptance. 

 

Login 

Username: UXXXX Password: xxxxx Role: EPM 

 

Navigation 

Construction > Contract Administration > Contract 07817[X] > Contract Times tab > 
Informational Times 

 

1. On the S&C-NOISSUES, in the Actl Compl date, enter 02/15/2018. 

2. Click Save. 

3. Click the Expand/Collapse Arrow next to FNLACCEPT Time ID record. 

4. Verify the Planned Occurrence date is 02/25/2018. 

5. On the FNLACCEPT recurring time, enter 02/26/2018 in the Actual Occurrence date. 

6. Click Save. 

7. Return to Contract Time tab. 

8. Next to FNLDUECONT Time ID, click the Expand/Collapse Arrow. 

9. Verify the Planned Occurrence date is 05/07/2018. 

10. Under the Site Time, click on the 00 AT Time ID link. 

11. Click on the Units and Dates tab. 

12. Verify the Actual Completion is 02/26/2018. 
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70.  Run the Certificate of Completion of Construction 
Contract report. 

 

Login 

Username: Uxxxx Password: xxxxxx Role: EPM 

 

Navigation 

Use the following link (Ctrl+Click): 

JRS Certificate of Completion of Construction Contract OR 

Home > External Links>Jasper Reports > Login > View > Repository > MDT > Protected > 
AASHTOWare > _Use Case Testing Reports > Construction > Certificate of Completion of 
Construction Contract 

 

1. In the District, select Glendive. 

2. In the Contract, select 07817[X]. 

3. Click Apply. 

4. Hover over the Export icon, select PDF.  

5. Print the report. 

 


